# Table of Contents

**SENSIT Test and Measurement Overview** ........................................................................................................ 1
**Operating Systems** ........................................................................................................................................... 1
**Installed Files** ................................................................................................................................................ 1
**Supported Devices** .......................................................................................................................................... 5
**Release History** ................................................................................................................................................ 6
  - Current Release (Version 2.6) ...................................................................................................................... 6
  - Previous Releases (Version 2.5) ................................................................................................................ 8
  - Previous Releases (Version 2.4) ................................................................................................................ 9
  - Previous Releases (Version 2.3) ................................................................................................................ 10
  - Previous Releases (Version 2.2) ................................................................................................................ 27
  - Previous Releases (Version 2.1) ................................................................................................................ 34
  - Previous Releases (Version 2.0) ................................................................................................................ 35
  - Previous Releases (Version 1.2) ................................................................................................................ 37
  - Previous Releases (Version 1.1) ................................................................................................................ 38
  - Previous Releases (Version 1.0) ................................................................................................................ 39
**Release Information** ...................................................................................................................................... 40
**Copyright** ......................................................................................................................................................... 40
**Disclaimer** ....................................................................................................................................................... 40
**Contact Information** .................................................................................................................................... 40
SENSIT Test and Measurement Overview
This document outlines the information related to the release of SENSIT Test and Measurement.

Operating Systems
SENSIT Test and Measurement is intended for use with one of the following Windows operating systems:

- Windows 10 x64
- Windows 10 x86
- Windows 8.1 x64
- Windows 8.1 x86
- Windows 8 x64
- Windows 8 x86
- Windows 7 x64
- Windows 7 x86
- Windows Vista x64
- Windows Vista x86
- Windows XP x64
- Windows XP x86

Installed Files
The following files are installed with this release:

- SENSIT 2.4\ADODB.dll
  DevExpress.Charts.v16.2.Core.dll
  DevExpress.Data.v16.2.dll
  DevExpress.Office.v16.2.Core.dll
  DevExpress.Pdf.v16.2.Core.dll
  DevExpress.Printing.v16.2.Core.dll
  DevExpress.Sparkline.v16.2.Core.dll
  DevExpress.Utils.v16.2.dll
  DevExpress.Utils.v16.2.UI.dll
  DevExpress.XtraBars.v16.2.dll
  DevExpress.XtraCharts.v16.2.dll
  DevExpress.XtraCharts.v16.2.UI.dll
  DevExpress.XtraCharts.v16.2.Wizard.dll
  DevExpress.XtraEditors.v16.2.dll
  DevExpress.XtraGrid.v16.2.dll
  DevExpress.XtraLayout.v16.2.dll
  DevExpress.XtraNavBar.v16.2.dll
  DevExpress.XtraPrinting.v16.2.dll
DEVEXpress.XtraRichEdit.v16.2.dll
DEVEXpress.XtraTreeList.v16.2.dll
DEVEXpress.XtraVerticalGrid.v16.2.dll
FUTEK_USB_DLL.DLL
Interop.Microsoft.Office.Core.dll
Janus.Windows.Common.v2.dll
Janus.Windows.GridEX.v2.dll
SENSIT.exe
SENSIT.exe.config

- Resources
  - Files
    - SENSIT EULA.rtf
  - Fonts
    - Alphanumeric_LCD_FUTEK_IHH500.gfs
    - Alphanumeric_LCD_FUTEK_IHH500.ttf
  - Manuals
    - Software Manual.pdf
- Release Notes
  - SENSIT Release Notes.pdf
- Settings
  - Backup Utility
    - EEPROM
      - ReadMe.txt
    - Memory
      - ReadMe.txt
  - Calibration
    - Calibration Technician.txt
    - ReadMe.txt
  - Data Logging
    - Auto Chart.txt
    - Create File Path Directory.txt
    - Default File Path Directory.txt
    - Graph Values.txt
    - ReadMe.txt
    - Start Type.txt
    - Test Duration.txt
    - Threshold Value.txt
    - X Axis Values.txt
  - Data Logging Backup
    - CalculatedValuesBackup.txt
    - Data Logging Backup Enabled.txt
    - ExportFileAttributes.txt
    - GraphValues.txt
    - ReadMe.txt
SENSIT Release Notes

TestProperties.txt
XAxisValue.txt

- **Device**
  ReadMe.txt

- **Live Graph**
  Auto Chart.txt
  Create File Path Directory.txt
  Default File Path Directory.txt
  Graph Values.txt
  ReadMe.txt
  Refresh Rate.txt
  Samples to Display.txt
  Start Type.txt
  Test Duration.txt
  Test Interval.txt
  Threshold Value.txt
  X Axis Values.txt

- **Math Channel**
  Enable Channel.txt
  Math Channel Units.txt
  Math Decimal Format.txt
  Math Values.txt
  ReadMe.txt

- **Scale Method**
  ReadMe.txt

- **Sensor**
  ReadMe.txt

- **Sum Channel**
  Enable Channel.txt
  ReadMe.txt
  Sum Channels.txt
  Sum Decimal Format.txt
  Sum Values.txt

- **System**
  Display Refresh Rate.txt
  Display Table Column Names.txt
  Front Panel Orientation.txt
  Front Panel Zoom.txt
  ReadMe.txt

- **TEDS**
  ACDCCouplingEnum.txt
  AnalogOutputSetupEnum.txt
  BridgeTypeEnum.txt
  CalSetEnum.txt
Chr5Enum.txt
CJSourceEnum.txt
DirectionEnum.txt
ElecSigTypeEnum.txt
ElectricalValuePrecisionEnum30.txt
ElectricalValuePrecisionEnum33.txt
ExcitationPowerRequirementsEnum.txt
ExciteTypeEnum.txt
GageTypeEnum.txt
ManufacturerIDEnum.txt
MapMethEnum.txt
MicSizeEnum.txt
MicTypeEnum.txt
PhysicalMeasurandUnitsEnum.txt
PolarizationEnum.txt
ReadMe.txt
Resp_TypeEnum.txt
SignEnum.txt
TCTypeEnum.txt
VersionLetterEnum.txt
YesNoEnum.txt
Supported Devices

The following devices are supported with this release:

- ETH Category
  ETH100

- IDA Category
  IDA100

- IDC Category
  IDC100
  IDC200

- IHH Category
  IHH500

- IPM Category
  IPM650

- USB Category
  USB100
  USB110
  USB120
  USB200
  USB210
  USB215
  USB220
  USB230
  USB240
  USB320
  USB410
  USB520
  USB530
Release History

Current Release (Version 2.6)

SENSIT Test and Measurement Version 2.6.2.0

Release Version

Version Number: 2.6.2.0
Version Released: October 25, 2018
Revision Type: Build Revision

New Features

- None.

Changes

- Updated Calibration Technician list in Calibration Settings.
- Updated Copyright information.
- Updated End-User License Agreement (EULA).

Fixes

- None.
SENSIT Release Notes

SENSIT Test and Measurement Version 2.6.1.0

Release Version

Version Number: 2.6.1.0
Version Released: October 11, 2017
Revision Type: Minor Revision

New Features

- Ability to enable and disable devices through SENSIT.
- Ability to turn on and off automatic detection of added or removed devices.
- Ability to set option to open an export file after creation.
- Ability to set threshold alarms on device outputs.
- Backup in Live Graphing.

Changes

- Warning to user when a calibration is about to take place stating that the operation can affect device output.
- Splash screen in data logging showing that a test is in progress.
- Indication in the display table that shunt and/or scale method is enabled.
- Profile serial number is included in test exports.
- Warning in scale method if a device’s units are not in mV/V.
- Steps to enable scale method has been updated to a more intuitive interface.
- Status column in display table has been removed.
- millinewton (mN) unit has been added.
- Ability to set alias for a math or sum channel.

Fixes

- Sampling rate is included to CSV exports.
- IDA units are no longer being updated when SENSIT is opened or closed.
- SENSIT no longer will detect non-FUTEK devices.
- Calculator will now show entire formula.
- Fixed bug related to reloading of calibration technician name.
Previous Releases (Version 2.5)

SENSIT Test and Measurement Version 2.5.1.0

Release Version

Version Number: 2.5.1.0
Version Released: May 08, 2017
Revision Type: Minor Revision

New Features

- Ability to calibrate the IDA through shunt.

Changes

- Ability to add and remove devices in SENSIT without restarting session.
- Virtual Mode can be enabled in SENSIT in the Display Table when no devices are enabled.
- All grid user interface controls have been replaced with DevExpress grid controls.
- Test data is exported if a device errors out during a test.
- Removal of device selection form that was presented when starting SENSIT.

Fixes

- Fixed bug where data logging backup was not working with particular cultural settings.
- Fixed bug where SENSIT would crash if a device errored out during a Live Graph or Data Logging test.
Previous Releases (Version 2.4)

SENSIT Test and Measurement Version 2.4.0.0

Release Version
Version Number: 2.4.0.0
Version Released: February 03, 2017
Revision Type: Minor Revision

New Features
- Added elapsed time option to record time from the start of the test rather than the time of day.
- Added new chart designer for data logging and live graphing.

Changes
- PBI 1269 – Removed number of samples and ADC value columns from tables and when exported to a file.
- PBI 1271 – Updated chart settings to allow peak, valley and/or tracking values to be displayed and exported.
- Updated chart controls for data logging and live graphing.
- Updated model selection flow layout control to only display connected models and added IDA image.

Fixes
- Bug 2483 – Fixed issue with cultural information when exporting comma/decimal to Excel.
- Bug 2783 – Fixed issue with unit conversion when using the TEDS profile in IHH500/IPM650.
- Bug 2784 – Fixed issue with incorrect context menu being displayed in display mode for IHH500.
- Bug 2785 – Fixed issue with decimal point precision going to infinity when using the TEDS profile in IHH500/IPM650.
- Bug 3083 – Fixed issue with data logging where an exception is thrown when using the IHH500.
- Bug 3412 – Fixed issue with live graph where the sum channel fails when devices included in sum channel are not enabled for the live graph chart.
Previous Releases (Version 2.3)

SENSIT Test and Measurement Version 2.3.4009.0

Release Version
Version Number: 2.3.4009.0
Revision Type: Build Revision / Bug Fix

New Features
- Data Logging
  - Added a new setting to create a backup file containing the data collected during the test.
  - Added a function to stop a test that is in progress.
  - Added a function to restore the test from the backup file.

Changes
- Display Table
  - Update readings and units of measure when changed on the IHH and IPM front panel keypad.
- Sum Channel
  - Replaced Enable Channel Button with ToggleSwitch.
  - Replaced Tracking, Peak and Valley Value Buttons with RadioButtons.
  - Replaced Sum Channel Buttons with CheckBoxes and only display available channels.
- Math Channel
  - Replaced Enable Channel Button with ToggleSwitch.
  - Replaced Tracking, Peak and Valley Value Buttons with RadioButtons.
  - Updated saved settings to include the formula from the calculator.
- Calculator
  - Replaced Close Button with Apply Button.
  - Removed Postfix Notation TextBox.
  - Combined Infix Notation, Result and Display TextBoxes into a Panel.
  - Infix Notation is now referred to as Formula.
- Data Logging Settings
  - Removed Apply Button.
  - Moved several GroupBoxes into a FlowLayoutPanel to only display relevant settings to the models selected.
- Data Logging Graph
  - Changed default series width (line thickness) to 2 pixels.
- Live Graph Settings
  - Removed Apply Button.
- Live Graph
  - Changed default series width (line thickness) to 2 pixels.
- Calibration Settings
  - Removed Apply Button.
SENSIT Release Notes

- Culture Information
  - Removed Apply Button.

Fixes
- Fixed a threading issue where the Live Graph test would not stop when the Stop Test Button is pressed and the Math Channel is enabled.
- Fixed a threading issue where the Live Graph test would throw a System.IndexOutOfRangeException stating “There is no row at position …”
- Fixed an issue where the Live Graph would move off the graph completely when the X-Axis Value is set to Time.
SENSIT Test and Measurement Version 2.3.4008.16

Release Version
Version Number: 2.3.4008.16
Version Released: June 17, 2016
Revision Type: Bug Fix

New Features
 Added calibration support for the IDC200.

Changes
 Updated calibration settings control layout.
 Moved the settings directory, subfolders and files to the resources directory.

Fixes
 None.
SENSIT Test and Measurement Version 2.3.4008.15

Release Version
Version Number: 2.3.4008.15
Version Released: June 09, 2016
Revision Type: Bug Fix

New Features
- Added device support for the IDC200.

Changes
- None.

Fixes
- Removed unused local variables.
SENSIT Test and Measurement Version 2.3.4008.14

Release Version
Version Number: 2.3.4008.14
Version Released: January 22, 2016
Revision Type: Bug Fix

New Features
- None.

Changes
- None.

Fixes
- Fixed an exception where the Serial Number ComboBox failed to list all of the available serial numbers. The exception may occur when non-FUTEK USB devices are connected that use the same FTDI drivers.
SENSIT Test and Measurement Version 2.3.4008.11

Release Version
Version Number: 2.3.4008.11
Version Released: November 12, 2015
Revision Type: Bug Fix

New Features
- None.

Changes
- None.

Fixes
- Fixed an unhandled exception in live graphing during the export of data to Microsoft Excel. The exception only occurs when using a combination of an IHH/IPM and USBXXX.
SENSIT Test and Measurement Version 2.3.4008.10

Release Version
Version Number: 2.3.4008.10
Revision Type: Bug Fix

New Features
- None.

Changes
- None.

Fixes
- Fixed production features used by the factory.
SENSIT Test and Measurement Version 2.3.4008.9

Release Version
Version Number: 2.3.4008.9
Version Released: July 31, 2015
Revision Type: Bug Fix

New Features
- None.

Changes
- None.

Fixes
- Fixed production features used by the factory.
SENSIT Test and Measurement Version 2.3.4008.8

Release Version
Version Number: 2.3.4008.8
Version Released: April 16, 2015
Revision Type: Build Revision / Bug Fix

New Features
- None.

Changes
- None.

Fixes
- Fixed the timing related to the calibration procedure of the IHH500 and IPM650.
SENSIT Test and Measurement Version 2.3.4007.7

Release Version
Version Number: 2.3.4007.7
Version Released: August 12, 2014
Revision Type: Build Revision / Bug Fix

New Features
- None.

Changes
- None.

Fixes
- Fixed the default load switch settings related to the USB520 and USB530.
SENSIT Test and Measurement Version 2.3.4006.6

Release Version
Version Number: 2.3.4006.6
Version Released: July 22, 2014
Revision Type: Build Revision / Bug Fix

New Features
- None.

Changes
- None.

Fixes
- Fixed the timing related to the calibration procedure of the IDA100.
SENSIT Test and Measurement Version 2.3.4005.5

Release Version

Version Number: 2.3.4005.5
Version Released: April 30, 2014
Revision Type: Build Revision / Bug Fix

New Features

- None.

Changes

- None.

Fixes

- Fixed an error that resulted when using TEDS and Data Logging.
SENSIT Test and Measurement Version 2.3.4004.4

Release Version
Version Number: 2.3.4004.4
Version Released: February 26, 2014
Revision Type: Build Revision / Bug Fix

New Features
▪ None.

Changes
▪ Updated the labels for IHH500 and USB520 for use at the factory.

Fixes
▪ None.
SENSIT Test and Measurement Version 2.3.4003.3

Release Version

Version Number: 2.3.4003.3
Version Released: January 23, 2014
Revision Type: Build Revision / Bug Fix

New Features

- Added support for the ETH100, IDA100 and USB240.
- Added support for IHH500 and USB520 for use at the factory.

Changes

- Updated the Resources directory for better file management.

Fixes

- None.
SENSIT Test and Measurement Version 2.3.4002.2

Release Version
Version Number: 2.3.4002.2
Version Released: August 23, 2013
Revision Type: Build Revision / Bug Fix

New Features
- Added configuration support for the IHH500 and IPM650.
- Added support for quadrature encoders.
- Added Transducer Electronic Data Sheets (TEDS) automation to support factory calibrations.
- Added database tables to support the TEDS automation at the factory.

Changes
- Updated the calculations to support quadrature encoders based on hardware and firmware versions.
- Updated file and directory names to reduce the number of characters in the file path.
  - Please note: This may affect the saved settings created in a previous version of SENSIT. The settings may have to be saved again using the newer version of SENSIT.
- Updated the setup.exe prerequisites to support the latest hardware drivers.

Fixes
- None.
SENSIT Test and Measurement Version 2.3.4001.1

Release Version
Version Number: 2.3.4001.1
Version Released: June 07, 2013
Revision Type: Build Revision / Bug Fix

New Features
- Added device support for the USB530.
- Added a warning message to alert the user when the software is unable to find the FTDI Drivers. The message indicates the options that the user has to resolve the issue or to continue to use the software in the Virtual Mode.

Changes
- Updated the setup and deployment package to make use of InstallShield.

Fixes
- Fixed the Virtual Mode to support the use of SENSIT without a FUTEK USB Device being present.
- Fixed the Angle Reset to support USB410, USB520 and USB530.
SENSIT Test and Measurement Version 2.3.4000.0

Release Version
Version Number: 2.3.4000.0
Version Released: February 21, 2013
Revision Type: Minor Revision

New Features
- Added device support for the USB520.
- Added the ability to enable / disable the tracking, peak and valley values from the Data Logging Graph and the Live Graph.
- Added a warning message to alert the user that the software will be launched in Virtual Mode.
- Added an Export option to the Data Logging and Live Graph tabs that allows the user to export even after the test results have already been exported.
- Added the ability to show or hide selected columns and rows from the Display Table.
- Added the ability to copy data from the Data Logging and Live Graphing Tables.
- Added a descriptive alias field for each unique device serial number that can be saved.

Changes
- Changed the default file names used when exporting data to include date and time.
- Changed the Display Table Refresh Rate to include additional intervals from 0.1 Hz to 25 Hz.
- Changed the Live Graph Test Interval to allow inputs by the user as small as 0.005 seconds (200 SPS).
- Restructured the subroutines used to export data to .csv and .txt files in order to decrease the export time.
- Restructured the subroutines used to export data to .xls and .xlsx files in order to allow for larger amounts of data acquisition.

Fixes
- None.
SENSIT Release Notes

Previous Releases (Version 2.2)

SENSIT Test and Measurement Version 2.2.4006.5

Release Version
Version Number: 2.2.4006.5
Version Released: August 06, 2012
Revision Type: Build Revision / Bug Fix

New Features
- Added the ability to support TEDS sensors programmed for legacy instruments.
- Added the ability to correct for symmetry differences in TEDS sensors using dual scaling.

Changes
- Updated the scope of Microsoft Excel from a global variable to a local variable.
- Updated the files used to store TEDS settings to text documents (*.txt).
- Updated the FTDI D2XX Drivers from version 2.08.14 to 2.08.24.

Fixes
- Fixed the application data directory to include the files that relate to TEDS settings.
SENSIT Test and Measurement Version 2.2.4005.4

Release Version
Version Number: 2.2.4005.4
Version Released: June 25, 2012
Revision Type: Bug Fix

New Features
 Added the ability to save the display table column names.
 Added the ability to save the conversion units.

Changes
 Updated the sum channel to display the conversion units instead of the base calibration units.
 Updated the sum channel to not display units when the selected channels have different conversion units.

Fixes
 Fixed the algorithm used to determine if the trial period is expired or has been modified.
 Fixed the calculation used with TEDS to handle arithmetic overflow exceptions.
 Fixed the formatting of data when saving settings to accommodate different regional settings.
SENSIT Test and Measurement Version 2.2.4004.3

Release Version
Version Number: 2.2.4004.3
Version Released: May 21, 2012
Revision Type: Bug Fix

New Features
- None.

Changes
- None.

Fixes
- Fixed the algorithm used to determine if the trial period is expired or has been modified.
- Fixed the file path used to open the Software Manual from the Help Menu.
- Fixed the Data Logging Counter used when logging data with the Normal_Data_Request command.
SENSIT Test and Measurement Version 2.2.4003.2

Release Version
Version Number: 2.2.4003.2
Version Released: May 03, 2012
Revision Type: Bug Fix

New Features
- None.

Changes
- Reorganized the collection order of the Calibration Mode Tab.

Fixes
- Fixed the algorithm used to determine if the trial period is expired or has been modified.
SENSIT Test and Measurement Version 2.2.4002.1

**Release Version**

<table>
<thead>
<tr>
<th>Version Number:</th>
<th>2.2.4002.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version Released:</td>
<td>May 01, 2012</td>
</tr>
<tr>
<td>Revision Type:</td>
<td>Bug Fix</td>
</tr>
</tbody>
</table>

**New Features**

- None.

**Changes**

- None.

**Fixes**

- Fixed the software to allow the user to continue using the software with limited functionality once the Trial Period has expired.
SENSIT Test and Measurement Version 2.2.4001.0

Release Version
Version Number: 2.2.4001.0
Version Released: April 28, 2012
Revision Type: Build Revision

New Features
- None.

Changes
- Updated the connection string related to the database used to store calibration information generated by FUTEK personnel only.

Fixes
- None.
SENSIT Test and Measurement Version 2.2.4000.0

Release Version
Version Number: 2.2.4000.0
Version Released: April 19, 2012
Revision Type: Minor Revision

New Features
- Added the features that were exclusively available in the SENSIT Instrument software to this release.
  - Display Front Panel
  - Data Logging Registers
  - Live Graph Registers
  - Transducer Electronic Data Sheets (TEDS)
- Added device support for the IHH500, IPM650, USB215 and USB410.
- Added the use of a product key to validate the license that has been purchased.
- Added the use of a trial period for those who would like to evaluate the software.
- Added the model selection form when multiple model categories are detected.
- Added the ability to select which device(s) to use when data logging or live graphing.
- Allowed the live calibration feature in the Calibration Mode to be used with a valid license or before the trial period expires.

Changes
- Updated the software name to SENSIT Test and Measurement.
- Removed Global Mode from the File Menu and added Global Settings to the Display Settings Menu.
- Removed some of the items from the Format Menu to allow the settings from the operating system to be used instead.
- Reorganized the setup or settings for data logging, live graphing and calibration.
- Updated the units displayed in the Scale Method section to reflect the calibrated units of the device.
- Updated the installation process to automatically prompt the user to install the prerequisite software.

Fixes
- The Refresh Rate in Live Graph Settings now accepts the input of a single-precision floating-point number instead of a 32-bit signed integer.
- The Status in the Device Settings is now saved.
- The default location used when saving a data logging or live graph file has been updated to support the different directories in the supported operating systems.
Previous Releases (Version 2.1)

SensIT Test and Measurement Version 2.1.4000.0

Release Version

Version Number: 2.1.4000.0
Version Released: November 17, 2011
Revision Type: Minor Revision

New Features

- Added device support for the USB120 and USB320.
- Added Unit Codes table to the Additional Information section.
- Added the Shunt feature to the Calibration Mode.
- Added the Culture Information to the Format Menu which allows the user to select the regional settings to use when formatting numbers, dates and time.
- Added the support of different directories based on the supported operating systems.

Changes

- Updated the software name to SensIT Test and Measurement.
- Reorganized the settings for data logging, live graphing and calibration.
- Restructured the read and write subroutines related to the packetized data transfer in order to optimize the response time.
- Added an additional layer of error checking to the read and write subroutines allowing for the retransmission of data within the allotted time.

Fixes

- None.
Previous Releases (Version 2.0)

SensIT USB Software Version 2.0.4000.0

Release Version
Version Number: 2.0.4000.0
Version Released: July 27, 2011
Revision Type: Build Revision

New Features
- None.

Changes
- Updated the software name to SensIT USB Software.
- Updated the build revision to reflect the Microsoft .NET Framework use and the build number.
  - Build revision 4000 represents Microsoft .NET Framework 4.0 and build number 00.

Fixes
- None.
FUTEK USB Software Version 2.0.0.0

Release Version
Version Number: 2.0.0.0
Version Released: January 25, 2011
Revision Type: Major Revision

New Features
- Complete redesign of the Graphical User Interface (GUI).
- Added support for up to 16 different devices at once.
- Added support for exporting data to .xls or .xlsx files.
- Added the ability to modify individual device settings or apply settings globally.
- Added the ability to save settings for future use of the software.
- Added the ability to modify the look and feel of the software through the Format Menu.
- Added the Additional Information to the Help Menu which allows the user to review the current settings of the software and firmware that relate to a specific device.

Changes
- Upgraded to Microsoft .NET Framework 4.0.
- Updated the data logging feature to capture data based on the hardware’s sampling rate.
- Updated the graphing capabilities to make use of newer and more powerful controls.
- Updated the main display to a tabular format to accommodate future releases and flexibility.

Fixes
- This release was a major revision and was not released to fix any previous releases.
Previous Releases (Version 1.2)

Version Number: 1.2.0.2
Version Released: October 05, 2010
Revision Type: Bug Fix

Version Number: 1.2.0.1
Version Released: July 02, 2010
Revision Type: Bug Fix

Version Number: 1.2.0.0
Version Released: May 03, 2010
Revision Type: Minor Revision
## Previous Releases (Version 1.1)

<table>
<thead>
<tr>
<th>Version Number</th>
<th>Version Released</th>
<th>Revision Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1.0.3</td>
<td>September 01, 2009</td>
<td>Bug Fix</td>
</tr>
<tr>
<td>1.1.0.2</td>
<td>August 17, 2009</td>
<td>Bug Fix</td>
</tr>
<tr>
<td>1.1.0.1</td>
<td>June 30, 2009</td>
<td>Bug Fix</td>
</tr>
<tr>
<td>1.1.0.0</td>
<td>May 27, 2009</td>
<td>Minor Revision</td>
</tr>
</tbody>
</table>
### Previous Releases (Version 1.0)

<table>
<thead>
<tr>
<th>Version Number</th>
<th>Version Released</th>
<th>Revision Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0.0.1</td>
<td>May 19, 2009</td>
<td>Bug Fix</td>
</tr>
<tr>
<td>1.0.0.0</td>
<td>February 04, 2009</td>
<td>First Release</td>
</tr>
<tr>
<td>1.0.0.0</td>
<td>October 07, 2008</td>
<td>Beta Version</td>
</tr>
</tbody>
</table>
Release Information

SENSIT Test and Measurement Version 2.4.0.0 Release Notes – Released February 2017
SENSIT Test and Measurement Version 2.5.1.0 Release Notes – Released May 2017
SENSIT Test and Measurement Version 2.6.1.0 Release Notes – Released October 2017
SENSIT Test and Measurement Version 2.6.2.0 Release Notes – Released October 2018

Copyright

Disclaimer
Neither the whole nor any part of the information contained in, or the product described in this manual, may be adapted or reproduced in any material or electronic form without the prior written consent of the copyright holder.

This product and its documentation are supplied on an as-is basis and no warranty as to their suitability for any particular purpose is either made or implied.

This document provides preliminary information that may be subject to change without notice.

Contact Information
FUTEK Advanced Sensor Technology, Inc.
10 Thomas, Irvine, CA  92618, USA

Telephone:   (949) 465-0900
Fax:   (949) 465-0905

Email (All Inquires):  futek@futek.com
Website URL:  www.futek.com